
Busta n. 1 

La/il candidata/o illustri le azioni da intraprendere per risolvere i problemi di spazio sugli scaffali 

della biblioteca. 

Con riferimento al mondo accademico, la/il candidata/o illustri quali sono i principali programmi 

gratuiti per la gestione della bibliografia. 

The European Commission, as well as other funding bodies, requires that those who had access to 

funding (Horizon 2020, Horizon Europe, ERC, MSC) make peer-reviewed scientific publications 

reporting the results of the research projects available to Open Access. It also requires that the data 

generated during the research process and necessary to validate the results presented in a scientific 

publication (underlying data) are deposited in a research data repository and made available with 

the fewest possible restrictions. In 2018 the Academic Senate of the University of Padua issued the 

"Policy on the management of research data", recognizing that "research data constitute the 

heritage of the university institution, as well as a resource 4 even in the long term 4 for research, 

university teaching and the progress of society=. 

Busta n. 2 

La/il candidata/o illustri cosa s'intende per revisione delle collezioni in una biblioteca accademica, 

tratteggiandone principi, metodologie e procedure. 

La/il candidata/o illustri le strategie di valorizzazione delle raccolte possono essere approntate in 

generale, e quali specifiche iniziative possono essere adottate in una biblioteca accademica. 

At the beginning of a project, even before starting to create or collect data, it is necessary to plan 

how they will be managed: where they will be stored, with which software they will be processed, 

the solution to any privacy issues, who owns the rights, who can access them, and if and how they 

can be reused: the collection of all this information constitutes a Data Management Plan (DMP). The 

guidelines of the European funding programs provide that grant winners, in addition to making 

documents available to Open Access, must also fill in a DMP to be shown within the first 6 months 

from the beginning of the research activity. Any reasons that prevent the data or part of the data 

from being made accessible (confidentiality, security, intellectual property, etc.) must be justified in 

writing. i 
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Busta n. 3 

Con riferimento al Sistema bibliotecario dell'Universitá di Padova, la/il candidata/o illustri a cosa si 

fa riferimento con il termine <biblioteca digitale=. 

La/il candidata/o illustri le interazioni e il coordinamento tra attività di back office e attività di front 

line in una biblioteca. 

This document is an up-to-date, authoritative specification of all metadata terms maintained by the 

Dublin Core# Metadata Initiative. Included are the fifteen terms of the Dublin Core# Metadata 

Element Set (also known as "the Dublin Core") plus several dozen properties, classes, datatypes, and 

vocabulary encoding schemes. The "Dublin Core" plus these extension vocabularies are collectively 

referred to as "DCMI metadata terms" ("Dublin Core terms" for short). These terms are intended to 

be used in combination with metadata terms from other, compatible vocabularies in the context of 

application profiles. 

Busta n. 4 

Con riferimento al Sistema bibliotecario dell9Università di Padova, la/il candidata/o illustri unservizio 

per l'archiviazione a lungo termine degli oggetti e delle collezioni digitali. 

La/il candidata/o illustri le diversità tipologiche delle biblioteche, evidenziandone peculiarità e tratti 

comuni. 

Digital rights management (DRM), i.e. protection of copyrighted works by various means to control 

or prevent digital copies from being shared over computer networks or telecommunications 

networks. The digitalization of content has challenged traditional copyright laws on two fronts. First, 

it has enabled nearly cost-free reproduction and large-scale distribution of digital content. Second, 

existing digital content easily can be remixed and <mashed-up= (combined in various ways) with 

other content to produce new works. In response to these changes, copyright holders have sought 

greater protection through legal and technological remedies.



Busta n.5 

La/il candidata/o illustri quali sono gli scopi e l9articolazione di un Sistema Bibliotecario di Ateneo, 

anche in riferimento all9Università di Padova. 

La/il candidata/o illustri le diverse fasi del trattamento del libro. 

Prezi is a presentation tool that uses different media types to help make whatever is being shown 

as engaging as possible. This is specifically targeted at education, as well as business users. The free 

version offers lots of functionality, but there are more features on the education-specific tiered 

payment options. Everything is made with easy-to-use guidance and templates so it can be utilized 

both by educators and students alike. This is a helpful way to learn design but also acts as a useful 

online tool for sharing with students wherever they are, in or out of the class. 

Busta n. 6 

La/il candidata/o illustri caratteristiche e differenze tra open access, open source, open science. 

La/il candidata/o illustri i principali aspetti del trattamento catalografico di un libro. 

Zotero automatically senses research as you browse the web. Need an article from JSTOR or a 

preprint from arXiv.org? A news story from the New York Times or a book from a library? Zotero has 

you covered, everywhere. Zotero helps you organize your research any way you want. You can sort 

items into collections and tag them with keywords. Or create saved searches that automatically fill 

with relevant materials as you work. Zotero instantly creates references and bibliographies for any 

text editor, and directly inside Word, LibreOffice, and Google Docs. With support for over 10,000 

citation styles, you can format your work to match any style guide or publication. 
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Busta n. 7 

La/il candidata/o illustri caratteristiche, strumenti e risorse della biblioteca digitale e dei servizi 

connessi. 

La/il candidata/o illustri i principali aspetti del trattamento fisico/gestionale di un libro. 

Interoperability is a broad problem domain. It is typically investigated within a specific scope, such 

as Within a particular community (e.g., libraries, commercial entities, scientific communities), within 

a particular classification of information (e.g., electronic records, technical reports, software), or 

within a particular information technology area (e.g., relational databases, digital imaging, data 

visualization). Current research on interoperability in digital library architecture addresses the 

challenges of creating a general framework for information access and integration across many of 

the above domains. A common goal of these efforts is to enable different communities, with 

different types of information and technologies, to achieve a general level of information sharing 

and, through the process of aggregation and computation, to create new and more powerful types 

of information. 

Busta n. 8 

La/il candidata/o illustri che cosa sono gli indici bibliometrici. 

La/il candidata/o illustri le principali realizzazioni di cooperazione nel campo dei servizi bibliotecari. 

The following Guideline shows how the UNIMARC format is to be used when creating records for 

electronic resources. This Guideline was developed under the auspices of the IFLA Universal 

Bibliographic Control and International MARC (UBCIM) Programme. It results from meetings of the 

IFLA Permanent UNIMARC Committee and the requirements of the International Standard 

Bibliographic Description for Electronic Resources, ISBD(ER). At these meetings data elements used 

to describe electronic resources were compiled and their location in UNIMARC was determined. 

Besides additional fields or content designators redefinition of existing fields may prove necessary 

in the future. 



Busta n. 9 

La/il candidata/o illustri come effettuare la rilevazione della soddisfazione degli utenti nella 

biblioteca accademica e le ragioni strategiche della sua importanza. 

La/il candidata/o illustri criteri di formazione e gestione di un apparato di consultazione in una 

biblioteca accademica. 

Copyleft: license granting general permission to copy and reproduce intellectual property. Where 

copyright protects society's interests in invention and creativity by providing individual incentives 

through copyright control, copyleft protects social interests in knowledge creation by vesting 

copyright control in a large general community. The concept of copyleft is central to many 

programming projects, and the license is most commonly used for software, digital art, writings, and 

other creative content. Copyleft is a specific license granted under copyright law, and the 

international statutes governing copyright law are the mechanisms that establish and protect 

copyleft. Typically, copyleft is a general license agreement granted by a copyright owner permitting 

anyone to freely use copyrighted property but under specific terms. 

Busta n. 10 

La/il candidata/o illustri come operare una ricerca simultanea delle collezioni dell'Ateneo e delle 

biblioteche che partecipano al Sistema Bibliotecario Padovano. 

La/il candidata/o illustri come integrare i diversi canali di comunicazione e le diverse modalità di 

relazione in una biblioteca fisica. 

For several years the Digital Library Research Group at Cornell University and the Corporation for 

National Research Initiatives (CNRI) have been engaged in research focused on the design and 

development of infrastructures for open architecture, confederated digital libraries. The goal of this 

effort is to achieve interoperability and extensibility of digital library systems through the definition 

of key digital library services and their open interfaces, allowing flexible interaction of existing 

services and augmentation of the infrastructure with new services. Some aspects of this research 

have included the development and deployment of the Dienst software, the Handle System®, and 

the architecture of digital objects and repositories. 
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Busta n. 11 

La/il candidata/o illustri come raffinare la ricerca in GalileoDiscovery nel caso in cuii risultati ottenuti 

siano troppo numerosi. 

La/il candidata/o illustri come integrare i diversi canali di comunicazione e le diverse modalità di 

promozione dei servizi di una biblioteca digitale. 

The main difference between Prezi and PowerPoint is that Prezi is a cloud-based tool for creating 

non-linear presentations while PowerPoint is an offline tool for creating standard presentations. 

Prezi is a presentation app known mostly for its style of zoom navigation and a <slideless= design. 

The core concept of creating a presentation with Prezi is that all sections are connected and the 

presenter can zoom and navigate between them seamlessly. This style of presentation is unique to 

Prezi and it's their way of standing out above PowerPoint. Even though the zooming feature sounds 

complex as an idea, its ease of use is impressive, especially when following a template. 

Busta n. 12 

La/il candidata/o illustri come supportare l'erogazione dei servizi di accoglienza, orientamento e 

assistenza all'utenza all9interno delle biblioteche universitarie. 

La/il candidata/o illustri come una biblioteca può promuovere servizi inclusivi facilitando l'accesso 

agli spazi e al patrimonio bibliografico. 

The fastest way to create a basic web hyperlink on a PowerPoint slide is to press Enter after you 

type the address of an existing webpage. You can link to a webpage, or you can link to a new 

document or a place in an existing document, or you can begin a message to an email address. You 

can change the color of a hyperlink if you like. If you want to change the display text of a link, right- 

click it and select Edit Link. Select the hyperlink you want to re-color and on the Home tab of the 

ribbon, select down arrow next to the Font Color button to open the menu of colors. Once you've 

inserted the link, you can test it (in Normal view) by right-clicking the hyperlink and selecting Open 

Hyperlink 



Busta n. 13 

La/il candidata/o illustri cos'è e quali caratteristiche esprime l'UNlversal MAchine Readable 

Cataloguing 

La/il candidata/o illustri il ruolo dell9attività di misurazione e valutazione dei servizi all9interno della 

gestione di una biblioteca. 

If you are using PowerPoint 2013 or a newer version, you can link data from a saved Excel worksheet 

to your PowerPoint presentation. That way, if data in the worksheet changes, you can easily update 

it in your PowerPoint presentation. Link an entire Excel worksheet to PowerPoint: 1) In PowerPoint, 

on the Insert tab, click or tap Object; 2) In the Insert Object dialog box, select Create from file; 3) 

Click or tap Browse, and in the Browse box, find the Excel workbook with the data you want to insert 

and link to; 4) Before you close the Insert Object box, select Link, and click OK. The linked object in 

your presentation displays all the data from the active, top worksheet in the linked Excel workbook. 

When you save the Excel workbook, make sure the worksheet you want in your presentation is the 

one you see when you first open the workbook. 

Busta n. 14 

La/il candidata/o illustri cosa s'intende per auto-archiviazione di una pubblicazione, anche in 

riferimento alle policy degli editori. 

La/il candidata/o illustri attraverso una idonea esemplificazione le dimensioni dell'efficacia e 

dell9efficienza nelle attività di biblioteca. 

"People who use screen readers sometimes scan a list of links. Links should convey clear and 

accurate information about the destination. For example, avoid using link texts such as ""Click 

here,"" ""See this page,"" Go here,"" or ""Learn more."" Instead include the full title of the 

destination page. You can also add ScreenTips that appear when your cursor hovers over text or 

images that include a hyperlink. If the title on the hyperlink's destination page gives an accurate 

summary of what's on the page, use it for the hyperlink text. 

An accessible font doesn't exclude or slow down the reading speed of anyone reading a document, 

including people with low vision or reading disability or people who are blind. The right font 

improves the legibility and readability of the document."



Busta n. 15 

La/il candidata/o illustri cosa s'intende per metadati descrittivi in ambito bibliotecario e quali sono 

le principali caratteristiche. 

La/il candidata/o illustri obiettivi e metodi di misurazione della customer satisfaction in biblioteca. 

The UNIMARC bibliographic format contains data elements for the specification, description and 

identification of continuing resources. Continuing resources are bibliographic resources that are 

issued over time with no predetermined conclusion and they include serials and ongoing integrating 

resources. Definitions: Serial: a continuing resource issued in a succession of discrete issues or parts, 

usually bearing numbering, that has no predetermined conclusion. Examples include journals, 

magazines, electronic journals, continuing directories, annual reports, newspapers and 

monographic series. Ongoing integrating resource: a bibliographic resource that has no 

predetermined conclusion and is added to or changed by means of updates that do not remain 

discrete and are integrated into the whole. Examples include updating loose-leafs and updating Web 

sites. 

Busta n. 16 

La/il candidata/o illustri cosa s'intende per politica delle acquisizioni in una biblioteca accademica. 

La/il candidata/o illustri quali sono i principali interlocutori e gli strumenti più appropriati nella 

comunicazione di una biblioteca accademica. 

Prezi Video allows educators to present streamed video to the class from wherever they are. This, 

with Present, is more than just a video as you can add in images, graphs, documents, and more to 

be overlaid on the screen as you talk. Prezi Design is a template-based slideshow-style presentation 

builder. This lets you create a slideshow with rich media such as images, video, graphs, and more. 

Prezi Present is a bit like a combination of the above two, letting you create video-based 

presentations that combine slides, PowerPoints, videos, and more.



Busta n. 17 

La/il candidata/o illustri fruizione, circolazione, peculiarità di gestione degli e-book nella biblioteca 

accademica. 

La/il candidata/o illustri criteri di giudizio e di selezione nella scelta del materiale di scarto della 

gestione delle collezioni di una biblioteca. 

MARC is an acronym for Machine Readable Catalogue or Cataloguing. This general description, 

however, is rather misleading as MARC is neither a kind of catalogue nor a method of cataloguing. 

In fact, MARC is a short and convenient term for assigning labels to each part of a catalogue record 

so that it can be handled by computers. While the MARC format was primarily designed to serve the 

needs of libraries, the concept has since been embraced by the wider information community as a 

convenient way of storing and exchanging bibliographic data. 

Busta n. 18 

La/il candidata/o illustri gli e-journals, modalità di accesso e fruibilità da parte dell9utenza 

accademica e non. 

La/il candidata/o illustri criteri di acquisizione del materiale bibliografico in una biblioteca 

accademica. 

Items in Zotero libraries can be organized with collections and tags. Collections allow hierarchical 

organization of items into groups and subgroups. The same item can belong to multiple collections 

and subcollections in your library at the same time. Collections are useful for filing items in 

meaningful groups (e.g., items for a particular project, from a specific source, on a specific topic, or 

for a particular course). You can import items directly to a specific collection or add them to 

collections after they are already in your library. Tags (often called <keywords= in other contexts) 

allow for detailed characterization of an item. You can tag items based on their topics, methods, 

status, ratings, or even based on your own workflow (e.g., <to-read=). Items can have as many tags 

as you like, and you can filter your library (or a specific collection) to show items having a specific 

set of one or more tags. 
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Busta n. 19 

La/il candidata/o illustri gli strumenti di ricerca offerti dal Sistema Bibliotecario dell9Università di 

Padova. 

La/il candidata/o illustri la tipologia delle opere di consultazione di una biblioteca. 

So in 1977 the International Federation of Library Associations and Institutes (IFLA) published 

UNIMARC : Universal MARC format, stating that "The primary purpose of UNIMARC is to facilitate 

the international exchange of data in machine-readable form between national bibliographic 

agencies". This was followed by a second edition in 1980 and a UNIMARC Handbook in 1983. All 

focussed primarily on the cataloguing of monographs and serials and took advantage of 

international progress towards the standardisation of bibliographic information reflected in the 

International Standard Bibliographic Descriptions (ISBDs). 

Busta n. 20 

La/il candidata/o illustri i punti di forza e punti di debolezza di un periodico print + online. 

La/il candidata/o illustri strumenti e competenze per un reference service digitale. 

You can download free, pre-built document templates with useful and creative themes from Office 

when you click File > New in your Office app. Templates can include calendars, business cards, 

letters, cards, brochures, newsletters, resumes, and much more. You can use any template you 

download as-is, or you can customize it to meet your needs. When you select a template you'Il be 

presented with a dialog box that shows you a larger view of the template. To download and use it, 

click the Create button and a new file will be created for you, using that template, all ready for you 

to customize with your information.



Busta n. 21 

La/il candidata/o illustri in quale modo il Sistema Bibliotecario può essere coinvolto nelle attività di 

terza missione di un Ateneo. 

La/il candidata/o illustri metodi e competenze necessari per la progettazione di interventi di 

formazione degli utenti nelle biblioteche accademiche. 

Best practices for making Word documents accessible: Avoid common accessibility issues such as 

missing alternative text (alt text) and low contrast colors; In general, avoid tables if possible and 

present the data another way; If you have to use tables, use a simple table structure for data only, 

and specify column header information; Use built-in headings and styles; Include alt text with all 

visuals; Add meaningful hyperlink text and ScreenTips; Ensure that color is not the only means of 

conveying information; Use sufficient contrast for text and background colors; Avoid writing 

important information in the Header or Footer sections of the document. 

Busta n. 22 

La/il candidata/o illustri in quale modo le biblioteche e i sistemi bibliotecari sono coinvolti nelle 

strategie Open Access di un ateneo 

La/il candidata/o descriva almeno due risorse bibliografiche elettroniche tra quelle sottoscritte dal 

Sistema Bibliotecario di Ateneo. 

A PivotTable is a powerful tool to calculate, summarize, and analyze data that lets you see 

comparisons, patterns, and trends in your data. PivotTables work a little bit differently depending 

on what platform you are using to run Excel. After creating a PivotTable and adding the fields that 

you want to analyze, you may want to enhance the report layout and format to make the data easier 

to read and scan for details. To change the layout of a PivotTable, you can change the PivotTable 

form and the way that fields, columns, rows, subtotals, empty cells and lines are displayed. To 

change the format of the PivotTable, you can apply a predefined style, banded rows, and conditional 

formatting. To make substantial layout changes to a PivotTable or its various fields, you can use one 

of three forms: Compact form; Tabular form, Outline form 



Busta n. 23 

La/il candidata/o illustri l9organizzazione dei servizi al pubblico in una biblioteca accademica. 

La/il candidata/o descriva le principali implicazioni del diritto d'autore nella gestione della 

biblioteca. 

Use accessible font color: the text in your document should be readable in a high contrast mode. 

For example, use bright colors or high-contrast color schemes on opposite ends of the color 

spectrum. White and black schemes make it easier for people who are colorblind to distinguish text 

and shapes. Here are some ideas to consider: 1) to ensure that text displays well in a high contrast 

mode, use the Automatic setting for font colors; 2) Use the Accessibility Checker to analyze the 

document and find insufficient color contrast. The tool now checks the documents for text color 

against page color, table cell backgrounds, highlight, textbox fill color, paragraph shading, shape and 

SmartArt fills, headers and footers, and links; 3) use the Colour Contrast Analyser, a free app that 

analyzes colors and contrast, and displays results almost immediately. 

Busta n. 24 

La/il candidata/o illustri la differenza tra periodici, opere in continuazione e collane. 

La/il candidata/o illustri i possibili sistemi di collocazione adottabili in una biblioteca. 

Powtoon is a presentation tool designed for both business and school use, based on the idea to take 

otherwise standard presentation slides and make it more fun and exciting using video animations. 

This is a great tool for teachers hoping to engage the class more digitally. But it's also a really 

powerful way for students to express themselves in a more creative way. The fact they're learning 

a new tool while doing that is just a useful bonus. With ready-made templates, online access, and 

teacher-specific features, this is a very appealing tool. But is it what you need to help your class? 



Busta n. 25 

La/il candidata/o illustri la differenza tra pubblicazione ad accesso aperto e deposito nell'archivio 

istituzionale denominato Padua Research Archive. 

La/il candidata/o illustri il ruolo delle biblioteche nel promuovere in modo efficace una cultura 

dell'Information Literacy. 

In Excel, you can enter simple formulas to add, divide, multiply, and subtract two or more numeric 

values. Or use the AutoSum feature to quickly total a series of values without entering them 

manually in a formula. After you create a formula, you can copy it into adjacent cells 4 no need to 

create the same formula over and over again. All formula entries begin with an equal sign. For simple 

formulas, simply type the equal sign followed by the numeric values that you want to calculate and 

the math operators that you want to use 4 the plus sign to add, the minus sign to subtract, the 

asterisk to multiply, and the forward slash to divide. Then, press ENTER, and Excel instantlycalculates 

and displays the result of the formula. The formula that you enter in a cell remains visiblein the 

formula bar, and you can see it whenever that cell is selected. 

Busta n. 26 

La/il candidata/o illustri le banche dati citazionali e in quali occasioni possono essere utilmente 

consigliate all9utenza di una biblioteca accademica. 

La/il candidata/o illustri in quale modo il Sistema Bibliotecario può essere coinvolto nelle attività di 

didattica di un Ateneo. 

By default when you copy (or cut) and paste in Excel, everything in the source cell or range4data, 

formatting, formulas, validation, comments4is pasted to the destination cell(s). This is what 

happens when you press CTRL+V to paste. Since that might not be what you want, you have many 

other paste options, depending on what you copy. For example, you might want to paste the 

contents of a cell, but not its formatting. Or maybe you want to transpose the pasted data from 

rows to columns. Or, you might need to paste the result of a formula instead of the formula itself. 

When you copy and paste formulas, you might need to fix cell references. However, references are 

not changed when you cut and paste formulas. 

#



Busta n. 27 

La/il candidata/o illustri le differenze tra catalogo, bibliografia e banca dati. 

La/il candidata/o illustri in quale modo le citazioni bibliografiche possono rappresentare un punto 

di partenza per la ricerca. 

Alt text helps people who can't see the screen to understand what's important in visual content. 

Visual content includes pictures, SmartArt graphics, shapes, groups, charts, embedded objects, ink, 

and videos. In alt text, briefly describe the image and mention its intent. Screen readers read the 

text to describe the image to users who can't see the image. Avoid using text in images as the sole 

method of conveying important information. If you must use an image with text in it, repeat that 

text in the document. In alt text, briefly describe the image and mention the existence of the text 

and its intents. To write a good alt text, make sure to convey the content and the purpose of the 

image in a concise and unambiguous manner. The alt text shouldn't be longer than a short sentence 

or two4most of the time a few thoughtfully selected words will do. 

Busta n. 28 

La/il candidata/o illustri le diverse peculiaritá dei codici bibliografici DOI, ISBN e ISSN 

La/il candidata/o illustri come integrare esigenze di conservazione del patrimonio ed esigenze di 

accesso all'informazione. 

Charts help you visualize your data in a way that creates maximum impact on your audience. You 

can start your document from a recommended chart or choose one from our collection of pre-built 

chart templates. Create a chart: 1) Select data for the chart; 2) Select Insert > Recommended Charts; 

3) Select a chart on the Recommended Charts tab, to preview the chart. You can select the data you 

want in the chart and press ALT + F1 to create a chart immediately, but it might not be the bestchart 

for the data. If you don't see a chart you like, select the All Charts tab to see all chart types. Tomake 

a chart easier to understand, you can add chart title and axis titles, to any type of chart. Axis titles 

are typically available for all axes that can be displayed in a chart 
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Busta n. 29 

La/il candidata/o illustri le diverse tipologie di banche dati messe a disposizione dal Sistema 

Bibliotecario dell9Università di Padova. 

La/il candidata/o illustri le principali attivita di un Servizio di supporto per chi pubblica in una 

biblioteca accademica. 

The Accessibility Checker is a tool that reviews your content and flags accessibility issues it comes 

across. It explains why each issue might be a potential problem for someone with a disability. The 

Accessibility Checker also suggests how you can resolve the issues that appear. In Word, the 

Accessibility Checker runs automatically in the background when you're creating a document. If the 

Accessibility Checker detects accessibility issues, you will get a reminder in the status bar. To 

manually launch the Accessibility Checker, select Review > Check Accessibility. The Accessibility pane 

opens, and you can now review and fix accessibility issues. Use the Accessibility Reminder add-in for 

Office to notify authors and contributors of accessibility issues in their documents. With the add-in, 

you can quickly add reminder comments that spread awareness of accessibility issues and 

encourage the use of the Accessibility Checker 

Busta n. 30 

La/il candidata/o illustri quali sono gli scopi dell9Archivio istituzionale dell9Università di Padova. 

La/il candidata/o illustri l9organizzazione delle informazioni all9interno della pagina web di una 

biblioteca. 

"Best practices for making PowerPoint presentations accessible: Include alternative text with all 

visuals; Make sure slide contents can be read in the order that you intend; Add meaningful and 

accurate hyperlink text and ScreenTips; Ensure that color is not the only means of conveying 

information; Use sufficient contrast for text and background colors; If you must use tables, create a 

simple table structure for data only, and specify column header information; Use a larger font size 

(18pt or larger), sans serif fonts, and sufficient white space. 

The Accessibility Checker is a tool that reviews your content and flags accessibility issues it comes 

across. It explains why each issue might be a potential problem for someone with a disability. The 

Accessibility Checker also suggests how you can resolve the issues that appear." 

Mk Ss 0 »



Busta n. 31 

La/il candidata/o illustri quali sono i servizi automatizzati in biblioteca, con particolare riferimento 

al Sistema Bibliotecario Padovano. 

La/il candidata/o descriva la differenza tra biblioteca a scaffale aperto, a scaffale chiuso, a scaffale 

misto. 

"People who use screen readers sometimes scan a list of links. Links should convey clear and 

accurate information about the destination. For example, avoid using link texts such as ""Click 

here,"" ""See this page,"" Go here,"" or ""Learn more."" Instead include the full title of the 

destination page. You can also add ScreenTips that appear when your cursor hovers over text or 

images that include a hyperlink. If the title on the hyperlink's destination page gives an accurate 

summary of what's on the page, use it for the hyperlink text. 

An accessible font doesn't exclude or slow down the reading speed of anyone reading a document, 

including people with low vision or reading disability or people who are blind. The right font 

improves the legibility and readability of the document." 

Busta n. 32 

La/il candidata/o illustri quali sono le modalitá di acquisizione di una risorsa elettronica, e quali 

modelli contrattuali. 

La/il candidata/o descriva l'iter di acquisizione e gestione di un abbonamento di periodico. 

In a PivotTable that is based on data in an Excel worksheet or external data from a non-OLAP (On- 

Line Analytical Processing) source data, you may want to add the same field more than once to the 

Values area so that you can display different calculations by using the Show Values As feature. For 

example, you may want to compare calculations side-by-side, such as gross and net profit margins, 

minimum and maximum sales, or customer counts and percentage of total customers. When you 

add two or more fields to the Values area, whether they are copies of the same field or different 

fields, the Field List automatically adds a Values Column label to the Values area. You can use this 

field to move the field positions up and down within the Values area. 
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Busta n. 33 

La/il candidata/o illustri quali strategie possono essere adottate per l9arricchimento e la 

manutenzione delle collezioni, cartacee ed elettroniche in una biblioteca accademica. 

La/il candidata/o descriva lineamenti e sviluppi degli standard catalografici. 

You can apply or change a style, border, or color of a table in your presentation. For example, you 

can apply or clear a table style (or Quick Style), erase lines from a cell, row, or column, change the 

border of the table, or change the background color of a table. A table style (or Quick Style) is a 

combination of different formatting options, including color combinations that are derived from the 

theme colors of the presentation. Any table that you add has a table style applied to it automatically. 

To remove a table style, select the Table Tools / Design tab on the ribbon. Then select the More 

drop-down arrow on the right of the Table Styles gallery, and choose Clear Table at the bottom. You 

can add or change the background color for the whole table. The background color appears 

underneath any fill color that is applied to the table cells. 

Busta n. 34 

La/il candidata/o illustri quali tipi di utenti possono presentarsi in una biblioteca accademica e quali 

servizi possono essere loro offerti. 

La/il candidata/o descriva finalità, articolazioni, ambiti operativi della catalogazione descrittiva. 

DSpace is an open source repository software package typically used for creating open access 

repositories for scholarly and/or published digital content. While DSpace shares some feature 

overlap with content management systems and document management systems, the DSpace 

repository software serves a specific need as a digital archives system, focused on the long-term 

storage, access and preservation of digital content. The optional DSpace registry lists almost three 

thousand repositories all over the world. DSpace is constructed with Java web applications, many 

programs, and an associated metadata store. The web applications provide interfaces for 

administration, deposit, ingest, search, and access. The asset store is maintained on a file system or 

similar storage system. The metadata, including access and configuration information, is stored in a 

relational database and supports the use of PostgreSQL and Oracle database. 
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Busta n. 35 

La/il candidata/o illustri somiglianze e differenze tra GalileoDiscovery e Zotero. 

La/il candidata/o descriva finalità, articolazioni, ambiti operativi della soggettazione. 

Portable Document Format (PDF) is a file format developed by Adobe in 1992 to present documents, 

including text formatting and images, in a manner independent of application software, hardware, 

and operating systems. Based on the PostScript language, each PDF file encapsulates a complete 

description of a fixed-layout flat document, including the text, fonts, vector graphics, raster images 

and other information needed to display it. PDF has its roots in "The Camelot Project" initiated by 

Adobe co-founder John Warnock in 1991. PDF files may contain a variety of content besides flat text 

and graphics including logical structuring elements, interactive elements such as annotations and 

form-fields, layers, rich media (including video content), three-dimensional objects and various 

other data formats. The PDF specification also provides for encryption and digital signatures, file 

attachments, and metadata to enable workflows requiring these features. 

Busta n. 36 

La/il candidata/o illustri le differenze tra Copyright e Copyleft. 

La/il candidata/o descriva finalità, articolazioni, ambiti operativi della classificazione. 

"How to create a Collection in DSpace - NB in the vast majority of cases, we don't create a Collection 

before receiving an associated submission, since we can always select or create an appropriate 

Collection for the dataset ourselves. Therefore, when a prospective submitter contacts us to request 

the creation of a collection, we ask them to first submit their data into the default holding collection, 

and we only create the new collection after we have received a dataset submission. Thus we avoid 

creating collections which might then never hold any deposits. 

1. Go to the Community in which you plan to add the new Collection. Under 8Context9 on the right 

of the screen click on 'Create Collection9. 

2. Add relevant metadata from the user pertaining to the Collection (usually Title, Short Description, 

Introductory Text fields). 

3. The Assign Roles page will be displayed...."



Busta n. 37 

La/il candidata/o illustri le modalità di gestione dei reclami in biblioteca. 

La/il candidata/o descriva finalità, articolazioni e sviluppi recenti dell9organizzazione dello spazio 

fisico delle biblioteche. 

"DSpace settings. Creating a group allows the SuperUser to assign permissions to collection 

administrators and Submitters. In some cases where many users need to have the same submitter 

status on multiple collections, then it is more efficient to just add them to the group, which already 

has submitter status on the collections, rather than adding each new user to each collection as an 

individual. 

Under Administrative on the menu click on 'Groups'. Click on the link 'Click here to add a new Group' 

link. Give the group a name. The two groups that we might sometimes create for a Collection are: 

GroupX_ADMIN and GroupX-USERS (e.g. for the School of Engineering we have 

ENGINEERING_USERS and for the Roslin Institute we have ROSLIN_USERS. We rarely create admin 

groups, since we rarely give users admin permissions on a collection, because of the training burden, 

but the possibility to do so exists). " 

Busta n. 38 

La/il candidata/o illustri il ruolo del <controllo di autorita= nel catalogo di una biblioteca. 

La/il candidata/o descriva caratteristiche di base, finalità, esempi di software di gestione per le 

biblioteche. 

To use the Find & Replace dialog: 1) Type the text you want to find in the Search for box. 2) To 

replace the text with different text, type the new text in the Replace with box. 3) You can select 

various options such as matching the case, matching whole words only, or doing a search for similar 

words. 4) When you have set up your search, click Find. To replace text, click Replace instead. 

Apache OpenOffice uses Regular Expression to perform wildcard searches. This is a powerful tool 

that can do complex text matching. If you click Find All, Writer selects all instances of the search text 

in the document. Similarly, if you click Replace All, Writer replaces all matches. Use Replace All with 

caution; otherwise, you may end up with some hilarious (and highly embarrassing) mistakes. A 

mistake with Replace All might require a manual, word-by-word, search to fix. 
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Busta n. 39 

La/il candidata/o illustri le modalità di classificazione di opere cartacee e opere digitali in una 

Biblioteca accademica. 

La/il candidata/o descriva le diverse modalità con cui un documento puo entrare a far parte della 

collezione di una biblioteca. 

Writer has several ways to view a document: Print Layout, Web Layout, and Full Screen. To access 

these and other choices, go to the View menu and click on the required view. (When in Full Screen 

view, press the Esc key to return to either Print or Web Layout view.) When in Print Layout, you can 

use both the Zoom slider and the View Layout icons on the status bar. In Web Layout, you can use 

the Zoom slider. You can also choose View > Zoom from the menu bar to display the Zoom ¬: View 

Layout dialog, where you can set the same options as on the Status bar. In Web Layout view, most 

of the choices are not available. Working with text (selecting, copying, pasting, moving) in Writer is 

similar to working with text in any other program. Apache OpenOffice also has some convenient 

ways to select items that are not next to each other, select a vertical block of text, and paste 

unformatted text. 

Busta n. 40 

La/il candidata/o illustri le caratteristiche della cooperazione catalografica all'interno della rete SBN. 

La/il candidata/o illustri con quali finalità e attraverso quale policy l'Università di Padova sostiene e 

promuove l'Open Access. 

You can bring data from one Access database into another in many ways. Copying and pasting is the 

simplest method, but importing and linking offer you better control and flexibility over the data that 

you bring, and over how you bring that data into the destination database. When you import from 

another database, Access creates a copy of the data in the destination database without altering 

the source. During the import operation, you can choose the objects you want to copy, control how 

tables and queries are imported, specify whether relationships between tables should be imported, 

and so on. You might want to import data for example to create some tables that are similar to 

tables that exist in another database. You might want to copy the entire table or just the table 

definitions to avoid manually designing each of these tables. When you choose to import only the 

table definition, you get an empty table. 
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Busta n. 43 

La/il candidata/o illustri le modalità di fruizione degli e-book in una Biblioteca accademica. 

La/il candidata/o illustri le caratteristiche di un archivio di dati FAIR. 

In a database, your information is stored in multiple related tables. To create a table: 1- When you 

open your database for the first time, you'll see a blank table in Datasheet view where you can add 

data. To add another table, click the Create tab > Table. You can either start entering data in the 

empty field (cell) or paste data from another source like an Excel workbook. 2- To rename a column 

(field), double-click the column heading, and then type the new name. Tip: Meaningful names help 

you know what each field contains without seeing its contents. Click File > Save. To add more fields, 

type in the Click to Add column. To move a column, select it by clicking its column heading, and then 

drag it to where you want it. You can also select contiguous columns and drag them all to a new 

location. 

Busta n. 44 

La/il candidata/o illustri le modalità di trattamento catalografico del patrimonio bibliografico antico. 

La/il candidata/o illustri in quale modo il Sistema Bibliotecario può essere coinvolto nelle attività di 

ricerca di un Ateneo. 

Ex Libris Alma is the only unified library services platform in the world, managing print, electronic, 

and digital materials in a single interface. As a completely cloud-based service, Alma provides 

libraries with the most cost-effective library management solution in the industry. Digital 

representations are quickly created from single or multiple files, either one-by-one or via an efficient 

bulk ingest program. Alma supports migration from third-party systems using standards like OAI- 

PMH, as well as automatic collection creation from EAD-formatted metadata. Alma's metadata, 

collections and workflow management interface for digital content mirrors that used for print and 

electronic resources. The resource digitization process, from request to curation, is streamlined and 

simple, while built-in analytics provide the insight needed for improved performance.



Busta n. 41 

La/il candidata/o illustri la gestione dei periodici in una biblioteca accademica. 

Nell9ambito dell9Open Access la/il candidata/o metta a confronto alcuni modelli di pubblicazione. 

A new report released by Alterline and sponsored by Ex Libris has unveiled important insights into 

emerging digital learning trends. The report, titled, What students want and need: How to deliver 

course materials to drive student success, surveyed 1,509 students from Australia, the United 

Kingdom and the United States. The findings show that students have a clear preference for digital 

materials and an expectation that these resources will be made easier to access. The report 

highlights the direct correlation between the ease of accessing course materials online and students= 

academic success. When students encounter obstacles in accessing materials, such as lack of online 

availability, broken links, or paywalls, it can severely hinder their progress and negatively affect their 

academic achievement. While laptops remain the primary choice for reading course materials and 

engaging in other learning activities on campus, smartphones are also an integral part of the learning 

process, especially for part-time students. 

Busta n. 42 

La/il candidata/o illustri significato e utilitá della letteratura grigia in una Biblioteca accademica. 

Con riferimento alla comunicazione e all'editoria scientifica odierna, la/il candidata/o illustri il 

processo della revisione tra pari (peer review). 

Alma's native deposit interface and support for the SWORD protocol make it easy for content 

creators 4 researchers, scholars and other community members 4 to directly enrich your digital 

collections. Full approval workflows ensure that sharing resources with your institution is easy, 

secure and complete.Your institutions unique content is protected in the Alma environment by the 

Amazon S3 cloud storage service. File integrity is continually verified and any checksum 

discrepancies are automatically corrected. These safeguards and data security measures are integral 

to Alma, relieving your library of all set-up and maintenance worries. Alma increases the visibility of 

your digital resources in discovery systems such as Primo and Summon, integrating digital, 

electronic and physical content in comprehensive result lists. 
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